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Welcome, new users!
This page was designed for people new to FlowJo to answer some of the most common questions
people have. Please click on a question below to see the answer.

What is FlowJo ?
What are the software/hardware requirements for FlowJo?
How do I get FlowJo?
How do I activate my FlowJo demo?
How can I buy FlowJo?
How do I learn FlowJo? 

What is FlowJo ?
FlowJo is a scientific analysis program for flow cytometric data. Flow cytometry is the study of
properties of suspended particles in a liquid. FlowJo is powerful enough to perform comprehensive
analyses of thousands of samples simultaneously.

Built into FlowJo are a wide array of visualization and gating tools, special platforms for kinetics, cell
cycle analysis, quantitation and compensation. FlowJo produces the best publication quality charting
available and introduces new technologies for presenting and publishing new data via the web.

What are the software/hardware requirements for FlowJo?
FlowJo for Macintosh requires a Power PC processor, running OS9.2, Jaguar, Panther or Tiger with at
least 128MB RAM and a USB port.
FlowJo for Windows requires a Pentium class or higher processor, running Windows 2000 or
Windows XP, with at least 512MB RAM and a USB port.
The amount of samples FlowJo can open depends on how much memory is installed.

How do I get FlowJo?
FlowJo can be downloaded (PC, Mac). If our webiste is down, you can request a free CD by calling
800 366 6045 or 541 201 0022. More contact info here. You can use the software free of charge for
30 days if you register.

How do I activate my FlowJo demo?
Activating your FlowJo demo means you'll be able to use your own data for analysis. Unactivated
demos will only let users work with our tutorial data. To activate your license, please fill out and
submit the request form and a serial number will be sent to your email address.
PC users will open the FlowJo preferences (edit menu item, preferences, look in the lower left for a
field labeled "serial number").
Mac users will open the "about flowjo" dialog from the apple menu, click "enter new serial number",
paste the serial number from your email there, and click "use serial number".

How can I buy FlowJo?
If you think FlowJo is right for you, you can by all means buy it. Our pricing is here. We only
discount prices for Universities (30%) and software resellers (10%).
You can order FlowJo online with a credit card or a PO (USA) or fax your order in, or call it in
(contact info)

How do I learn FlowJo?
A good place to start is with the tutorials. The basic tutorial teaches you basic FlowJo operations, such
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as adding sample data files, graphing them, and creating simple layouts. The advanced tutorial is
longer and addresses complex analysis needs and batching.

New to FlowJo?

• 
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Overview 
This page describes some of the basic concepts underlying FlowJo; it is meant to help you familiarize
yourself with some of the terminology and the features of FlowJo. As you navigate through the main
documentation, you will get more details about all of these topics.  In addition, you can follow links to
some special topics regarding FlowJo:  The all-important Credits page, where we have the
opportunity to thank the many individuals who have spent much time and effort helping us make
FlowJo the most sophisticated analysis package around, a Frequently-Asked Questions page (FAQ),
listing some common questions and answers, a page about getting Help from within FlowJo itself, and
a page detailing the history of revisions to FlowJo.

What does FlowJo do?

FlowJo should be the first step in the process of analyzing flow cytometry data.  FlowJo can analyze
data generated by any flow cytometer from any manufacturer.  FlowJo has a number of different
analysis platforms that let you not only perform standard analyses such as gating and statistics, but
also specialized analyses such as DNA/Cell Cycle, Kinetics (Calcium flux), Proliferation, Calibration,
and Statistical Comparison.  You may find that FlowJo's sophisticated tools for generating output
(graphical or tabular) are sufficient for you to generate publication-quality material.... but if not,
FlowJo makes it easy for you to copy any graphs, statistics, or other information into other programs
for further analysis and presentation.

Experiments and workspaces

FlowJo is a program designed to analyze flow cytometry data. The basic concept behind this analysis
is that of the experiment. An experiment is a collection of samples which have a set of common
attributes;  for instance, there are sets of tubes stained with the same antibodies, other sets of tubes
which come from the same tissue sources, etc. An experiment can be a single collection of samples, or
it can stretch across multiple runs over a period of months.

With FlowJo, you will organize the samples in a workspace. A Workspace is similar to a notebook: it
references every sample that you are analyzing, and records the analyses (gates, statistics, graphs,
tables) that you have done. You can close the workspace, and then reopen in the future and start
where you left off. You can have as many workspaces as you want; the organization is up to you. We
recommend that you have at least one workspace for every experiment.

Within a workspace, you can group samples by various attributes. For instance, you can make a group
of all samples derived from a single individual (which may have different stains); you can also make
groups of all samples with the same stains (which come from different individuals). Groups are really
the powerful feature of FlowJo: when you perform an operation on a group, it performs the operation
on every sample belonging to that group. Thus, you can apply a gate or a statistic to a group, and that
gate or calculation will be automatically performed on all samples!

[Top]

Analyzing with FlowJo

You will find that your mode of operating FlowJo will probably be very similar to the following
series of steps:

Overview 4



Load the samples into a workspace.1. 
Group samples for analysis with common procedures.2. 
Analyze a single prototype sample in detail. Decide on gates, statistics, etc.3. 
Apply the appropriate analyses to all the samples in a group.4. 
Quickly check the samples in the group to make sure the gates are acceptable: they may need
minor modifications to accommodate sample to sample variation.

5. 

Generate a graphical layout in which you can display particular graphs from all samples.6. 
Generate a table in which you can generate particular statistics from all samples.7. 

You can then save this workspace as a template... Next week, when you do another (similar)
experiment, most of the work is already done for you! You simply have to import the new samples
into the template workspace you created before:  all of the data files will be added to the appropriate
groups, which means all of your previous analyses (gates & statistics, etc.) will be automatically
applied to each sample. You need only regenerate the graphical layouts and the tables.

[Top]

The Gating Hierarchy

Another fundamental concept in FlowJo is that of the gating hierarchy. When you first generate a gate
on a sample (for instance, a lymphocyte gate), FlowJo shows you this gate (subset) in the paradigm of
a genealogical tree. In other words, the Lymphocyte subset is a child of the parent sample. It is shown
in the workspace underneath the sample, indented a single level from the sample. If you were to make
another gate on the sample (for instance, monocytes) FlowJo will create another new subset as
another child of the sample; now, the lymphocyte and monocyte subsets (or gates) are siblings.

Any operation that you can perform on a sample can also be performed on a subset of the sample.
Therefore, you can view the lymphocyte subset and create gates (subsets) of this population. If you
create a T cell gate within lymphocytes, then the T cell subset becomes a child of the lymphocytes
(and, by extension, a grandchild of the sample).

This paradigm is very important to the way in which FlowJo operates. When you copy analyses like
gates, you can choose to copy only the single gate that you click on, your you can choose to copy it
with all of its children (i.e., copy the entire analysis tree). You can copy the gate with its parents as
well. Remember, any subpopulation is a single gate. When you want to recreate the same
subpopulation on another sample, you need to carry all of the gates (all of the ancestors of the subset)
with the subpopulation when you copy it.

[Top]

Batch operations

Batch operations (repetitive analyses performed on multiple samples) are very simple in FlowJo. In
general, batch operations are performed on all samples in the currently selected group (therefore, you
will want to create sample groups that will serve to help you generate batch outputs). Batch operations
include copying gates and analyses, generating graphical layouts, and generating tables. In addition,
there are some minor operations like opening a graph of a subset as you are viewing from all samples
in the group, unifying the analyses across samples within a group, deleting analyses, and so forth.

In this way, FlowJo is a program that doesn't just analyze individual data samples. Rather, the focus is
on analyzing groups of samples, experiments, or even multiple experiments at once.

Table of Contents
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Compensation

In the world of increasing fluorescence parameters, it has become impossible to fully compensate
samples at the time of collection. FlowJo provides an interface for computing the compensation
matrix based on the collection of singly-stained samples. You can then apply this compensation
matrix to samples that are uncompensated. At this point, you can view and analyze the compensated
data.

[Top]

Derived Parameters

FlowJo lets you define new parameters for samples. These include the ability to add Time as a
parameter (for performing kinetics analyses), to compute the ratio of two collected parameters, or to
convert between log and linear scaling. Derived parameter definitions can be copied to entire groups
of samples.

Kinetics (Ca++ flux) analyses

FlowJo provides a sophisticated platform designed to analyze kinetics data. The sample must have a
parameter which corresponds to time (and is named "Time"); if it does not, FlowJo allows you to
create a time parameter (assuming a constant event rate). From this platform, you can compute the
maximal response time, the slope of a response, the fraction of responding cells, etc.

[Top]

Cell Cycle Analysis

The Cell Cycle Platform is easy to use, yet can view several different models simultaneously,
constrain fitting parameters, and automatically calculate the percentage of cells in G1, S, or G2
peaks.  Fitting can be constrained in a number of ways, letting you generate reasonable interpretations
of even very unusual cell cycle distributions.  All models can be copied between populations or
samples, with the same easy drag and drop interface used to propagate other gates or analyses.

Calibration (Quantitation)

FlowJo has a unique Calibration Platform that allows you to calibrate any collected parameter. Most
commonly, this is used to convert the scaling into absolute number of molecules (given a standard
that converts between the fluorescence intensity collected on your instrument and absolute numbers of
fluorophores). The platform can use a calibrated bead set as a standard, a stained sample as a
reference, or numbers that you enter to define the calibration manually.

[Top]

Proliferation Analysis

The Proliferation Platform is used to model proliferation data obtained using cell tracking dyes such
as CFSE. FlowJo presents a graphical display as well as information about each generation in the
subset. The proliferation platform also provides information about the fraction of cells from the
original population that have divided, and the number of times these cells have divided. In addition
the FlowJo Proliferation Platform draws gates that separate each generation.

Table of Contents
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Movies

Movies.  An analysis platform unique to FlowJo:  view your data dynamically.  Use the Movie
Platform to generate graphs as a function of time (kinetic analyses), or to generate a graph of one or
two parameters as a function of a third.  This unique visualization lets you uncover subtle
relationships in your data that would be impossible to see otherwise.

Backgating Analysis

Once your analysis contains subpopulations produced by gating within gates, it can be useful to see
the source of a given subpopulation rendered graphically. Backgating analysis shows graphs of each
gating operation with the final subpopulation highlighted in the graph of each stage.

Statistics and Formulas

A host of standard statistical calculations can be performed on a subpopulation then generalized to the
whole experiment by batching. FlowJo will build a table of statistical analyses across groups of tubes
that you designate. These tables update continuously as long as you are modifying your experiment,
for example, by correcting gates. You can export these tables and work further in third party software.
You can also devise and apply your own formulas within FlowJo and use its tools to complete your
analysis across multiple populations without tedious duplication of effort. The tables you create can
be dragged and dropped from one workspace to another.

[Top]

Overview

• 
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Workspace Overview
FlowJo organizes all of your analyses into a "workspace". The workspace contains the following
information:

A list of all the samples that you have put into the workspace• 
A list of all the groups that you have created• 
All of the analyses (and results of calculations)• 
All compensation matrices that you have created or loaded• 
All table definitions that you created• 
All layout definitions that you created• 

This information is at your fingertips through the workspace window.

Your workspace is like your laboratory notebook. You can save it, and then re-open it in the future
and continue your analyses from where you left off. It will remember everything that you do
(although you can choose to delete analyses or samples and they will be forgotten). Workspaces can
become templates for batch analyses of many experiments--you can load as many samples as you
wish into a single workspace.

How you organize your workspaces is up to you. We recommend that you assign each experiment a
workspace. Remember that you can copy analyses between workspaces; there is no limitation
imposed by maintaining multiple workspaces. Of course, all batch analyses are limited to samples
within a single workspace, so you will want to keep all similarly-analyzed samples (even from
different experiments) in the same workspace. You may have as many workspaces open at the same
time as you wish.

Workspace Overview 8



For an explanation of the elements of the window, click here.

Workspaces: an overview

• 
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Adding Samples
To analyze samples, you must first create a new workspace and then add the sample files to this
workspace. Add samples by clicking on the Add Sample button in the workspace (leftmost function

button). 
You will be shown the standard Macintosh Open File dialog. You can add a single file by opening
that file directly. If FlowJo determines that this is an FCS file, it will read it in and add it to the current
group.

Alternatively, you may select a folder and click on the button Add all files in folder. FlowJo will then
look at every file in the folder you specify. If it is an FCS file, it will be added to the workspace. In
addition, FlowJo will create a new group that has the same name as the folder you selected; the files
you just read in will be added to the folder. This way you can add an entire experiment at once!

Finally, if you select the button Add all files in all folders, FlowJo will look within the folder you
select and (1) add all FCS files in that folder; (2) search within each folder contained therein for FCS
files and add them; and (3) continue this search as deep as possible (i.e., looking for data in folders
within folders).  Each time a data file is encountered, FlowJo will create a new group with the name
of the folder that the data file is in and put the data file in that group.

Note: You can also add sample files (or folders of sample files) by simply dragging and dropping the
files from the finder to the workspace window.

Reading samples into workspaces

• 
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Groups
Groups are the heart of all the powerful tools in FlowJo. A group is a collection of samples-and a
mechanism by which analyses can be applied uniformly to that collection of samples. Any given
sample may belong to one or more groups. FlowJo lists the groups in the upper portion of the
workspace window.

There is a special case group: the "All Samples" group. It contains (by definition) all of the samples
known to the workspace. The "All Samples" group can neither be renamed nor deleted.

Groups are created in one of two ways:

(1) When you read in a folder of data files, FlowJo creates a group with the name of the folder and
automatically adds the samples to the group; or

(2) You can create a new group by clicking on the New Group button under the Workspace menu.

When you create the group, you are given the option of adding samples to the group which fit a set of
criteria-this is specified by the Create Group dialog window. In addition, you can specify that these
criteria should be checked anytime new samples are added to the workspace: if the new samples meet
those criteria, they are added to the group (and group-based analyses are automatically performed at
once.)

You can add samples from the workspace to any group. Just click on the sample and drag it to the
group. To remove a sample from a group, select the group, then select the sample and press the delete
key. If the current group is All Samples and you delete the sample, then you will be permanently
removing the sample from the workspace.

A group behaves in some ways as a "template sample" for its members. In other words, you can drag
gates or statistic nodes to a group exactly the same way as you would to another sample. The only
difference is that these gates, after being added to the group, are then added to every sample
belonging to the group. This is one of the ways in which FlowJo performs batch analyses. For hints on
creating groups to efficiently use this feature, click here.

There is one unbreakable rule with regards to groups: Every sample belonging to a group must
contain every analysis that has been applied to the group. Of course, if the group specifies analyses
that are not applicable to the sample, then this doesn't happen. (For example, if you have created a
gate based on compensated parameters, and a sample that is not compensated is added to the group,
then those gates cannot be added to that sample. Once you compensate the sample, however, the gates
will be automatically added.)

If a sample belongs to multiple groups, then it will have all of the analyses from all of the groups to
which it belongs. Whenever you add a sample to a group (by dragging it into the group), that group's
analyses are automatically applied to the sample.

Associated with group names is a color and text style. A gate that is attached to a sample through a
group operation appears in the same color and style as that group. Therefore, any gate within a sample
that has a group's color and style is guaranteed to be identical to the group's version of that gate.
When you change a group's version of a gate (by dragging a new version of that gate onto the group
or if you have the Synchronize Group's Gates option checked), then all samples with the group's
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version of the gate are likewise updated.

If you modify a sample's version of a group's gate (for instance, if you decide that a lymphocyte gate
for one sample should be slightly different and you move it), then that gate will now appear in the
workspace window in black and plain text (unlike the group's gates). This is how you can tell from the
text when a gate has been modified. However, if you checked the Synchronize Group's Gates option
when you created the group, any time you modify a gate on any sample, the group's gate is
automatically updated.

Note that modified gates will still behave in other ways like group gates: when you attach a
subpopulation to a group's gate, it will be attached to the same gate in all samples, whether or not they
are identical to the group's version of the gate.

If you have modified a gate and decide later that it should be identical to the group's version, you can
select the gate and choose the Unify analyses option under the Workspace menu. Likewise, if you
select a gate within a group and choose this menu option, then all sample's versions of this gate are
made identical to the group's version.

How do you know what the group's version of a gate looks like? Simply open any sample which has
the group's version of the gate (i.e. the node is displayed in the color and text style of the group). If
you change this sample's gate (move it), then you are only changing that sample's version. To change
the group's version, drag the node back onto the group after you have made the modification or if you
checked the Synchronize Group's Gates option when creating the group, the update happens
automatically.

If a sample belongs to multiple groups which all have an analysis of the same name, then the sample's
version of the gate will be whichever one it got first.

Deleting nodes associated with groups have special consequences:

If you delete the node in the group itself, then it is removed from the group. You are then
asked if you want to remove the same nodes from all of the samples; if you choose not to
remove them from the samples, they are left alone (but they are then owned by the
samples-i.e., drawn in black and plain text-since they no longer belong to a group).

♦ 

You cannot delete a sample's node which is identical to the group's node, since every sample
must have every analysis belonging to the groups that it is in.

♦ 

If you delete a node which is a modified version of the group's node, then FlowJo will replace
it with the original, group's version of the node.

♦ 

If you delete a sample from a group, then it is removed from the group but all analyses which
came from the group are still applied to the sample (but they are now owned by the sample,
not the group).

♦ 

If you delete a group, then all of the group's analyses nodes are assigned to the samples.♦ 
If you rename a sample's version of a group node, then a copy of that node is made with the
new name, and the sample will retain a node with the same name as the group's node.

♦ 

Groups

• 
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Batch Analysis
The real power of FlowJo as an analysis tool becomes immediately evident when you start to do
"batch" analysis; i.e., the repeated application of a set of analyses (gates, statistics, graphical outputs)
to a series of samples.

Application of analyses to other samples is very easy: simply click once on the analyses that you wish
to duplicate, and while holding down the mouse button - drag them to the destination sample. You can
select a single gate (by clicking), or select several independent gates (by shift-clicking and dragging
any of the selected gates).

You can also apply a set of analyses to all samples within a group simultaneously. Simply drag the
analyses trees onto the group. They are attached to the group itself, and then attached to each sample
that belongs to the group (assuming the analysis is valid for that sample). By using these kinds of
group analyses, you can assure that all samples are being analyzed identically. When you change a
group's version of an analysis (by dragging a new version of a gate onto the group), then all samples
belonging to the group will be automatically updated with the new copy (with the exception of those
samples which have "special" versions of such gates). These operations are fully explained in the
pages on group analyses .

Another kind of batch analysis is the extraction of statistical information from a series of samples.
This is accomplished through the table editor. Using the table editor, you specify what sorts of
statistical information you wish to collect for each sample. Then you create the table for the current
group; FlowJo allows you to save the table to a file (which you can export into a spreadsheet), to the
clipboard (so you can copy it directly into a spreadsheet), or print it out. In addition, FlowJo will save
the table AND open your favorite spreadsheet program AND copy the table into this program - all
with a single click! Table definitions are saved with the workspace so that you can use them again in
the future.

The final type of batch analysis is the extraction of graphical displays for a series of samples. For this,
you use the layout editor. The layout editor allows you to arrange several graphs on a drawing board.
This graphical layout is then applied to the series of samples in the current group; the result can be
saved to a disk file (PICT format), copied into other applications (such as Canvas), or printed.

Template workspaces save all the analyses (gates and statistics), table definitions and layout
definitions while removing the samples. Because FlowJo saves all of this information in the
workspace, it is a simple matter to read new samples into the same workspace that has been saved as a
template and then apply the same batch analyses to those samples.

A batch is composed of a series of tasks. The task is the unit of computation; that is the generation of
each statistic or graph, sorting of a list etc. FlowJo can execute tasks asynchronously, meaning that
you do not have to wait for all pending tasks to complete before interacting with the program. You
can even initiate new tasks while others are being completed, so that the amount of time you have to
spend waiting for the program is minimized. Because the tasks can also be sorted in such a way as to
reduce the loading and unloading of files, the asynchronous processing can actually be faster than
giving all of the computing resources to handling pending computations.

 See Also:  Groups , Layout Editor , Table Editor

Batch analysis

• 
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Statistics
There are several statistics that can be computed by FlowJo. Except for the Frequency of Parent,
which is always displayed for each subpopulation once it has been gated, statistics must be added as
separate nodes in the workspace window. Each statistic node holds a single value (a single statistic); it
is recomputed whenever a gate that affects that subset changes. The full list of statistics includes such
computations as median, mean, or frequency within a parent population.

Statistics can be added to populations in two ways: (1) by
selecting one or more populations and clicking on the Statistic function button in the workspace
window; this adds statistics to the selected populations, or (2) by viewing a population in a graph
window (right) and clicking on the Statistic button in that window. Both ways brings up the Statistics
Dialog window.

Statistics are displayed in the workspace window whenever they are calculated. If a statistic node in
the workspace does not show its value, then you may request it to be computed. Select any node
which has that statistic as a descendant (i.e., the population to which it is attached, or any parent of
that population), and select recalculate from the Workspace menu. All statistics can be hidden from
view by selecting Hide Statistics in the Workspace menu (show them by selecting Show Statistics in
the same menu.)

Statistics can be conveniently organized and exported by the table editor. Statistics nodes can be
dragged to the table definition; when the table is computed, then all statistic nodes will be updated and
computed.

In addition, you can drag statistics into the layout editor.  This will create a text box containing the
statistic description and the value; it will be updated whenever the statistic is modified (i.e., it is
"live").

Now you can build a table of statistics within the Layout editor. Click the Sigma button in the Layout
editor's tool palette. Drag a rectangle in the area where you want your statistical table to appear. To
construct the table, click here.
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Summary of Drag and Drop Examples
This series of examples is based on a workspace in which there were several samples collected from
different people. These samples were stained with CD4, CD8, and differentiation markers. The first
sample was analyzed in detail and gates were generated to define several T cell subsets.

A series of drag operations using different modifier keys will serve to show how drag and drop can be
used to replicate analyses between samples. (This information applies equally to performing
operations on groups, but the resulting behavior may be somewhat different. This is discussed fully in
the help on groups).

You may go through each of the examples in sequence, or jump straight to a specific example:

Dragging a single node• 
Dragging a node with its children• 
Dragging a node with its parents• 
Dragging multiple nodes• 
Dragging multiple nodes with children and parents• 
Replacing existing nodes• 

These examples are all based on copying analysis nodes from one sample to another. However, the
same options are available for dragging within a single sample, and for dragging to the table editor or
the layout editor.

Summary:

To select more than one analysis node, use the command key to select additional nodes. (Use shift key
if you want to select a range of nodes that are all siblings).

To take an entire analysis tree, click on the top-most node of the set of nodes you wish to take, and
drag with the option key down (select all children).

To take only a single analysis node with all the gates used to create it, select that node and drag with
the control key down (select all parents).

Thus, judicious use of selection and the modifier keys allows you to drop only the portion of the
original analysis tree that you want to move.

Dragging and dropping (copying) analysis nodes & trees

• 
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Unify Analyses
If you have modified a gate and decide later that it should again be identical to the group's version,
you can select the gated subpopulation in the Workspace and choose the Unify Analyses option from
the Workspace menu .

In the Workspace shown at the right, the gate defining the subset of Sample 2 has been adjusted. Its
text style has changed from bold to normal to indicate that it is no longer the same as the bold subsets.
To readjust the gate to match that of the group, select the subset, then Workspace > Unify Analyses.
The text style will return to bold, signifying the identity of the gates.

Likewise, if you select a group then choose a gated population within it, you can use Unify Analyses
to apply this GROUP version of the gate to any sample in the group whose gate has been changed.
Learn more about groups.

Unify Analyses

• 
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Compensation Overview
FlowJo gives you the ability to compensate your data. This may be necessary in cases where the
compensation was inappropriately set during sample collection (although if the sample was
over-compensated, then there is no recourse). Also, there may be cases where the instrument is not
capable of compensating between certain channels (for instance, to correct for the spillover between
fluorescein and Cy5PE).

For a description of why compensation is necessary, the underlying concepts behind compensation,
and some of the pitfalls of improper compensation, see the "Compensation: A Perspective" by Mario
Roederer (you need to be connected to a network to view this site).

FlowJo computes the compensation matrix on control samples much the way you would manually set
the compensation. To do this, you will select gates on positive and negative populations for each of
these stain, and tell FlowJo to calculate the compensation matrix based on these stains.

Thus, you must collect samples that are singly-stained (as well as unstained) for each of the
fluorescences that require compensation. Ideally, you would use a stain that only labels a portion of
the sample population, so that you have an unstained set of cells in each tube. It is important to
remember that the negative population and positive population must share the same autofluorescence
characteristics for compensation to be valid (i.e., don't use monocytes as a negative control for a
lymphocyte stain; if you are compensating a stain on fibroblasts, use an unstained fibroblast control).

Steps involved in compensation by FlowJo:

Define positive and negative gates for each fluorescence channel requiring compensation1. 
Open the Define Matrix tab; drag the positive and negative populations into the appropriate
boxes

2. 

Compute and save the matrix3. 
Apply the matrix to the appropriate samples4. 

If you need to generate another compensation matrix for other samples in the experiment, you can just
repeat steps 2 through 4 as needed.

FlowJo's compensation tool and its derived parameter tool are combined in one window, shown
below. With a population selected in the Workspace, select Compensation from the Tools menu.
Follow the links below for a more detailed description.

Clicking here activates the compensation process. If you have more than one matrix in the
tool, choose the one you want to work with from this list. The Define Matrix tab lets you
drop positive and negative gated subpopulations populations from the Workspace to define
the matrix values for this parameter.

1. 

The Edit Matrix tab lets you change the matrix numbers manually and also save and load
matrices.

2. 

The Assign Tubes tab lets you drag and drop uncompensated populations (or groups of them)
to a matrix in order to apply the matrix to the samples.

3. 

The list of a population's parameters appears here. Drag the subset formed by gating the
population that is negative for a parameter to the box marked Negative.

4. 

Drag the subpopulation gated as positive for a parameter to this box.5. 
Simplify the process by dragging the parent of the two gated populations to the AutoAssign
Box. Or control-select all parent populations after gating and drag them here.

6. 
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Clicking here switches to the Derived Parameter tools.7. 

Once you have defined a compensation matrix, it is saved with the workspace. You may subsequently
apply that compensation matrix to other samples in the same workspace by selecting it from the
menu. To use that matrix in other workspaces, save the matrix to a file (Edit Matrix tab, Save to File
button) and load the matrix file into the new workspace (Edit Matrix tab, Load from File button).
Note that a compensation matrix is generally valid only for samples collected during a single
collection run! However, you can also edit the matrix using the Edit Matrix tab.

Any sample that has been compensated is marked with a bar next to the sample name in the
workspace window. Compensated samples have new parameters added to their list: for each
fluorescence channel to be compensated, a new parameter is created. The parameter name is labeled
with "comp-": e.g., when FITC and PE are compensated against each other, two new parameters
named Comp-FITC and Comp-PE will be created. Remember to select these new parameters in the
graph or statistics windows when you want to view compensated data.

Name your matrix at any time by selecting Untitled-1 in the box at the top and typing in a name of
your choice. The new name will appear in the Compensation Matrices list at the left of the

Table of Contents
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Compensation tool.

FlowJo can transform the display of compensated data so that populations no longer are displayed
squished against the axis. This transformation does not alter the data in any way, it simply changes the
scale of the axis so that you can view negative numbers and therefore the entire population of cells as
a whole cluster. Please visit the display transformation web pages for more information.

You may also click on the topics below to get more help on:

The Compensation window♦ 
The compensation matrix file♦ 
Changing the compensation matrix manually♦ 
Display Transformation (for those pesky cells that get squished against the axis!)♦ 

Download a Compensation Workspace with Demo Data to try out this platform.

Download the Compensation Tech Note to print a short (four page) step-by-step guide.

Compensation

• 
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The Experiment Annotator
Clinical sites and high throughput research labs need to improve their level of automation, to
significantly decrease repetitive tasks, and to enable large scale tests. FlowJo's Experiment
Annotator makes setting up an experiment easier and faster, and saves time on experiments that must
be repeated.

The Experiment Annotator is a graphical user interface for describing an experiment's staining setup
using attribute/value pairs. Its point/click/drag/drop interface is quick and intuitive. In addition to
recording the experimental setup, the Experiment Annotator also allows the user to edit sample
descriptions after data collection.

Once the plate is annotated, the arrangement of cells can be entered into FlowJo's Workspace ( Misc
> Move Wells to Workspace) or saved and opened on the Cytek cytometer for acquisition of
matching samples. Samples with matching sample well enumeration will be annotated according to
the plate layout.

Drag Keywords and their values from this list onto the numbered squares representing sample
wells. Double click on an attribute or value in this column if you want to edit it.

1. 

Add to the list of attribute/value pairs by typing in these boxes. Click the plus sign to add to
the list. The highlighted pair, Investigator/Dr. Jones was added using this tool.

2. 

Attributes can also be dragged to staging wells, then moved en masse to the grid. First, drag
attributes to the Staging Well. This well has four attributes added. Then, highlight the target
sample well or wells. Then click the staging well to copy its contents to the sample well.
More staging wells can be added by selecting Misc > Add Staging Well from the menu.

3. 
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Click on the upper left square to select all sample wells. Or go to Edit > Select all. Select a
whole column or row at once by clicking on the numbers 1-12 or letters A-H. Hold the
control button while clicking to select multiple sample wells. Select any single well to
deselect all others.

4. 

This window displays the contents of the selected well, in this case well E5 with the red
arrow. E5 was filled by selecting it, then double clicking the staging well with the red 3.

5. 

The File menu includes the option to Save as XML. This writes a file that when opened on the Cytek
machine, will annotate the sample data during acquisition.

The Misc menu includes

Add Keywords from File, Attribute/Value pairs separated by a carriage return in a .txt file
will populate the list window with your own customised list of parameters.

♦ 

Clear Keywords, Empties the Attribute/Value list.♦ 
Toggle Notation, changes the markings within the cells from Row/Column notation (A1,
A2, A3 for example) to numbers only, 1-96, left to right, top to bottom.

♦ 

Move Wells to Workspace, transfers all wells with assigned attributes to the workspace.♦ 
The Experiment Annotator

• 
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Getting Help in FlowJo
FlowJo is littered with help buttons throughout the application. Clicking on one of these launches a
web browser to access our Web page describing that topic. Or, you can choose help from the Apple
menu while running FlowJo to go directly to the general help page.

Using the web browser, FlowJo gives you "context-sensitive help"--i.e., taking you to help
information specifically regarding the operation you are currently performing.

In addition, you can select the Help menu in the Workspace and choose FlowJo Reference Manual.
This will open a browser window with the Manual's Table of Contents displayed.

If you are not connected to the internet, FlowJo can access help files installed on your hard drive.
With the installation CD in your computer, browse to a folder called Documentation. Drag this folder
into the same folder on your hard drive as the FlowJo program. Now when you click on a help button,
FlowJo will access the reference manual from your computer.

Offline Documentation

You can download the latest FlowJo's manual onto your hard drive for use when you are not
connected to the internet from this page.

Getting help

• 
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Cancelling Batch Operations
Many, but not all, of the operations that you request FlowJo to perform can be canceled while they are
happening. In general, when you cancel an operation, all further calculations cease. In the case of
creating tables or layouts, this will stop any output from being generated. If you select many
subpopulations and accidentally double click on one of them (this directs FlowJo to open them all), it
may take some time for all of the graphs to be generated. If you cancel the operation, then FlowJo will
stop opening graphs (but leave the windows up for the ones it has already opened).

There are operations which cannot be canceled, in which case FlowJo will simply continue
computing.

Canceling operations that FlowJo is performing

• 
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Graph Window
The Graph window is the window in which FlowJo displays graphical data: contour plots, histograms, dot
plots, etc. From this window, you can draw gates to create subsets of the data and select a variety of different
representations of the data. To create this window, double-click on any population node within the sample list
in the workspace.

Click on the image at the right to learn more about each tool.

The graph window provides much information about the current subpopulation that it displays: cell counts and
frequencies (percentage of total sample), any statistics you have requested, and any gates that were computed
on the current population. There are controls to navigate the gating tree, so you can automatically go to the
graph display that you used to create this subpopulation; you can also automatically display any gate that is
created within this subpopulation.

Select a graph type from the Options menu. Select Save State to Preferences from the Edit menu. You are
saving your preference for that graph type. Each time you open a new graph, your saved graph type will be
displayed.

All graph windows have controls to navigate among the samples in the workspace window list. (Arrows,
upper right.) These controls let you quickly cycle between different samples to compare the graphs. When you
click on left and right arrows, the exact same graph for the next or previous sample which has the same subset
is shown. (This may mean that intervening samples, which don't have the same gates, are skipped.) The
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middle diamond buttons open a list of samples from which to choose the parent of the subpopulation you are
viewing, or to display that parent. You can also activate the next/previous command from the Graph menu at
the top of the monitor

.

Axis Labels

A graph's axis labels are drop-down menus. Left click on an axis label to open a list of that population's
parameters. Select from that list and that parameter is displayed on the corresponding axis. If you or your
cytometer have applied a compensation matrix to the population in the graph, those compensated parameters
will also be available for selection. Event Number is also avalable as a parameter by checking the box in the
Options menu.

When compensated parameters are displayed, the Display Transformation button appears beside the axis
label. Click it to add a transformation calculation to the axis. For more details, click HERE.

Select a specific topic for more information:

Table of Contents
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Graph window• 
Drawing gates• 
Changing gates• 
Manually entering a gate• 

The following types of graphs can be generated in the graph window:

Bivariate displays

Compare bivariate display types

Univariate displays

Probability contour plots• 
Pseudo-color density plots• 
Probability density plots• 
Dot plots• 

Histograms• 
CDF (cumulative distribution
function)

• 

You may also wish to look at the pages on copying graphics to other programs and generating
publication-quality graphs.

Graphs and Displays:
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Graph Types
There are a number of different types of graphs which FlowJo can show you in a graph window.
(Special graph types, such as Kinetics and Cell Cycle, can be displayed by launching the appropriate
platform).

Once you have a graph window open, you can easily switch between graph types either by selecting
the type (and/or options) from the "Graph" menu, or by opening the options disclosure triangle at the
bottom of the graph window.

When you close a graph window, FlowJo remembers exactly what you displayed (axes, options, and
graph type); the next time you open that subset for display, FlowJo will show you that graph! (The
exception to this rule is if you open the graph window using the "Open Parent" (up-arrow) button in a
graph window: this function opens the graph window as it looked when you created the gate for that
subset.)

There are two univariate display types, and four bivariate displays. Each has several different options
that can result in a wide variety of different graphics. Some are more suitable for publication in print,
and some are more suitable for generating presentation slides.

The following types of graphs can be generated in the graph window:

Bivariate displays

Compare bivariate display types

Univariate displays

Probability contour plots♦ 
Pseudo-color density plots♦ 
Gray scale density plots♦ 
Dot plots♦ 

Histograms♦ 
CDF (cumulative distribution
function)

♦ 

You may also wish to look at the pages on copying graphics to other programs and generating
publication-quality graphs.

Graphic displays

• 
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Gating
Gating is the most important aspect of analysis of complex data (like flow cytometric data). Gating
refers to the process of selecting a subset of the collected events for further analysis. You can continue
to gate subsets to generate further subsets, until you have a collection of only the cells for which you
want a graphic display or statistic analyzed.

The process of gating simply creates a new population. When you collect a sample and import it into
the workspace, FlowJo creates a "node" to represent that set of events. When you set a gate to select a
subset of the cells, FlowJo creates a new "node"--i.e., a new population. Any operation (graphic
display, statistic, gating) that can be performed on the sample can also be performed on a subset of the
sample--they are all just populations!

FlowJo organizes this information as "tree"--much like a family tree. The sample is the eldest
generation (ancestor). When you gate to create a subset, you generate a new node which can be
considered a "child" of the sample. The sample is the parent of the new subset. A second subset
created on the sample would be another child of the sample; it is a "sibling" of the first subset. You
can then gate on the data in a child to generate yet another generation ("grandchild")... Each new
generation is indented another level in the workspace window.

Naming subpopulations is important. You cannot have siblings with the same names, lest confusion
arise. In general, you should avoid using duplicate names of subpopulations within any given sample.
Click here for more information on naming populations.

To create a subpopulation, you will draw any of several different kinds of gates on a graphic plot of
the parent population. Once you have created the appropriate combination of gates and statistics on a
sample, you can easily copy the entire analysis at once to another sample, or to an entire set of
samples.

Click on one of the following topics related to drawing and manipulating gates:

Drawing new gates♦ 
Editing existing gates♦ 
Manually entering gate boundaries♦ 
Creating Quadrant gates♦ 
Copying gates♦ 
Graph Overview♦ 
Naming♦ 

Or, click here to go the overview on graph windows. Remember to enter page title and metatags
Gating: Creating new subpopulations

• 
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Platforms
FlowJo has several analysis platforms that provide capabilities beyond the gating and statistics used for most
simple data analysis.  All analysis platforms are fully integrated into the FlowJo paradigm:  i.e., they can be
easily applied to multiple samples (usually, by using Groups), they are easy to edit, and all operations are
saved with the Workspace for your permanent record.

Workspaces and Demo Data are provided for several of FlowJo's platforms so that you can try out these
features yourself (Demo Data downloads page). In addition, we have several short application guides (Tech
Notes) that give step-by-step instructions for FlowJo platforms and features. (Tech Notes downloads page)

FlowJo has the following analysis platforms:

Kinetics

Kinetics analyses provide you a powerful tool for computing parameter statistics as a function of time and
exporting the data or graphics, or statistics computed as a function of time.  If you did not collect a time
parameter, FlowJo will add one for you.  You can even use the Layout Editor to overlay time-series graphs to
compare different samples.

Cell Cycle Analysis

FlowJo gives you a sophisticated, yet easy-to-use interface to model DNA/Cell cycle data.  You can
simultaneously compute several different standard models, with the ability to constrain different model
parameters with the click of a mouse.

Proliferation Studies

FlowJo models proliferation data obtained using cell tracking dyes such as CFSE. FlowJo presents a graphical
display as well as information about each generation in the subset. The proliferation platform also provides
information about the fraction of cells from the original population that have divided, and the number of times
these cells have divided. In addition the FlowJo Proliferation Platform draws gates that separate each
generation.

Calibration

Using this platform, you can calibrate any of your fluorescence parameters.  The platform can use a calibrated
bead set as a standard, a stained sample as a reference, or numbers that you enter to define the calibration
manually.  FlowJo creates a calibrated parameter and displays all graphs and statistics in calibrated units such
as absolute number of molecules per cell.

Compensation

Sometimes your data is not properly compensated... sometimes, it is not possible to compensate your data on
the machine because of the complexity of the analysis.  FlowJo's compensation platform makes compensating
data much easier than compensation on the machine; you are always guaranteed a correctly-compensated
output!
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Derived Parameters

Let FlowJo calculate a ratio of two parameters, add a time parameter (in case you want to do Kinetics
analyses), or convert between log and linear scaling.

Boolean Gates

You can combine data from existing subpopulations into a gate with your choice of Boolean properties: And,
Or, And Not, Or Not.

Movies

An analysis platform unique to FlowJo:  view your data dynamically.  Use the Movie Platform to generate
graphs as a function of time (kinetic analyses), or to generate a graph of one or two parameters as a function
of a third.  This unique visualization lets you uncover subtle relationships in your data that would be
impossible to see otherwise.

Special Analysis Platforms:
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Derived Parameters
FlowJo allows you to add new parameters to your data. These parameters are not actually added to the
original data files; they are simply descriptions of new parameters that are stored with the workspace.
However, they behave in other regards like parameters that were collected: you can display them,
calculate statistics on them, etc.

Because they are not stored with the data file, they will not appear if you open the same sample in a
different workspace--you will have to add the derived parameters again in that workspace. Currently,
there is no way to copy derived parameter definitions between workspaces.

There are four derived parameter types that you can create: time, ratio, log->linear and linear->log .
Calibrated parameters are also derived parameters, but they are created using the Calibration
Platform. To add a derived parameter, select the sample in the workspace, and then select the Open
Compensation/DerivedParameters menu item from the Tools menu. You will be presented with a
dialog tool that allows you to specify the parameters to define. From this window, you can also
remove existing derived parameters. For detailed help with creating a derived parameter, click here.

You can add a Ratio Parameter: this is the ratio of any two collected parameters. This is commonly
necessary for calcium flux experiments, in which the ratio of Indo-1 fluorescence in two different
channels is related to the calcium concentration. You can choose to create a ratio parameter with
either linear or logarithmic scaling.

You can create a calibrated parameter. Using the Calibration Platform you can convert the scaling of
any parameter (for instance, to absolute number of molecules per cell). While the calibration platform
creates a derived parameter automatically, you may wish to apply such a calibration to other
samples--do this by selecting the appropriate derived parameter. Then drag the samples to which you
want to apply the calibrated parameter into the Assign Tubes tab (shown below). A light blue bar will
appear in the Workspace next to the calibrated tubes.

Finally, you can convert any collected parameter between log and linear. FlowJo will automatically
optimize the scaling of the converted parameter to show the maximum number of events.
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Creating derived parameters (time, ratios, log < - > lin conversion)• 
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Compensation Overview
FlowJo gives you the ability to compensate your data. This may be necessary in cases where the
compensation was inappropriately set during sample collection (although if the sample was
over-compensated, then there is no recourse). Also, there may be cases where the instrument is not
capable of compensating between certain channels (for instance, to correct for the spillover between
fluorescein and Cy5PE).

For a description of why compensation is necessary, the underlying concepts behind compensation,
and some of the pitfalls of improper compensation, see the "Compensation: A Perspective" by Mario
Roederer (you need to be connected to a network to view this site).

FlowJo computes the compensation matrix on control samples much the way you would manually set
the compensation. To do this, you will select gates on positive and negative populations for each of
these stain, and tell FlowJo to calculate the compensation matrix based on these stains.

Thus, you must collect samples that are singly-stained (as well as unstained) for each of the
fluorescences that require compensation. Ideally, you would use a stain that only labels a portion of
the sample population, so that you have an unstained set of cells in each tube. It is important to
remember that the negative population and positive population must share the same autofluorescence
characteristics for compensation to be valid (i.e., don't use monocytes as a negative control for a
lymphocyte stain; if you are compensating a stain on fibroblasts, use an unstained fibroblast control).

Steps involved in compensation by FlowJo:

Define positive and negative gates for each fluorescence channel requiring compensation1. 
Open the Define Matrix tab; drag the positive and negative populations into the appropriate
boxes

2. 

Compute and save the matrix3. 
Apply the matrix to the appropriate samples4. 

If you need to generate another compensation matrix for other samples in the experiment, you can just
repeat steps 2 through 4 as needed.

FlowJo's compensation tool and its derived parameter tool are combined in one window, shown
below. With a population selected in the Workspace, select Compensation from the Tools menu.
Follow the links below for a more detailed description.

Clicking here activates the compensation process. If you have more than one matrix in the
tool, choose the one you want to work with from this list. The Define Matrix tab lets you
drop positive and negative gated subpopulations populations from the Workspace to define
the matrix values for this parameter.

1. 

The Edit Matrix tab lets you change the matrix numbers manually and also save and load
matrices.

2. 

The Assign Tubes tab lets you drag and drop uncompensated populations (or groups of them)
to a matrix in order to apply the matrix to the samples.

3. 

The list of a population's parameters appears here. Drag the subset formed by gating the
population that is negative for a parameter to the box marked Negative.

4. 

Drag the subpopulation gated as positive for a parameter to this box.5. 
Simplify the process by dragging the parent of the two gated populations to the AutoAssign
Box. Or control-select all parent populations after gating and drag them here.

6. 
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Clicking here switches to the Derived Parameter tools.7. 

Once you have defined a compensation matrix, it is saved with the workspace. You may subsequently
apply that compensation matrix to other samples in the same workspace by selecting it from the
menu. To use that matrix in other workspaces, save the matrix to a file (Edit Matrix tab, Save to File
button) and load the matrix file into the new workspace (Edit Matrix tab, Load from File button).
Note that a compensation matrix is generally valid only for samples collected during a single
collection run! However, you can also edit the matrix using the Edit Matrix tab.

Any sample that has been compensated is marked with a bar next to the sample name in the
workspace window. Compensated samples have new parameters added to their list: for each
fluorescence channel to be compensated, a new parameter is created. The parameter name is labeled
with "comp-": e.g., when FITC and PE are compensated against each other, two new parameters
named Comp-FITC and Comp-PE will be created. Remember to select these new parameters in the
graph or statistics windows when you want to view compensated data.

Name your matrix at any time by selecting Untitled-1 in the box at the top and typing in a name of
your choice. The new name will appear in the Compensation Matrices list at the left of the
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Compensation tool.

FlowJo can transform the display of compensated data so that populations no longer are displayed
squished against the axis. This transformation does not alter the data in any way, it simply changes the
scale of the axis so that you can view negative numbers and therefore the entire population of cells as
a whole cluster. Please visit the display transformation web pages for more information.

You may also click on the topics below to get more help on:

The Compensation window♦ 
The compensation matrix file♦ 
Changing the compensation matrix manually♦ 
Display Transformation (for those pesky cells that get squished against the axis!)♦ 

Download a Compensation Workspace with Demo Data to try out this platform.

Download the Compensation Tech Note to print a short (four page) step-by-step guide.

Compensation

• 
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Calibrated Parameters: Overview
FlowJo has a unique platform that allows you to calibrate any collected parameter. This gives you the
ability to express any parameter's values (graphical display, any statistical calculations) in the units of
your choice. Most commonly, this is used to convert the scaling into absolute number of molecules
(given a standard that converts between the fluorescence intensity collected on your instrument and
absolute numbers of fluorophores).

Once you have created a calibrated parameter, it is added to your sample as if it were just another
parameter. You can apply the calibration standard to any other sample in your collection (and you can
apply the calibration to an entire group, if you wish). You may have as many different calibration
standards in a workspace as you want; in fact, you can even apply multiple calibration standards to the
same sample (a new parameter will be added for each calibration that you apply).

When you graph your data, select the calibrated parameter on the axis of choice--the scale values on
the axis are now drawn in your calibrated units! For example, if you calibrate to absolute number of
molecules per cell, then you can display these numbers on the axis. In addition, any statistics you
calculate (medians, CVs, etc.) will be expressed in units of absolute molecules. Finally, you can even
enter a gate based on those units: you could, for example, specify a gate on all cells with more than
5,000 molecules of an antigen.

Callibrate your samples to a reference when you have collected data on a standard sample which you
can use to convert one unit of measure to another. (for example, a commercial bead set where each
bead has a defined absolute intensity mapped to a known unit value; or, a sample stained with an
antibody that has a known binding capacity to the cells). When you use a reference, FlowJo
automatically finds all of the peaks in the fluorescence, and asks you to enter any or all of the
calibration values for those peaks. FlowJo then performs a linear (or logarithmic) least squares
regression to determine the best calibration value, and creates the calibrated parameter

A Calibration Standard is FlowJo's internal representation of the conversion of fluorescence to
absolute units. Calibration Standards are saved with the workspace in which they were created
permanently. They are accessible as Derived parameters; thus, if you want to apply a Calibration
Standard to another sample (after defining it), select Windows > Open Compensation/Derived
Parameter Editor select its name in the Derived Parameters list click the Assign Tubes tab and
drag tubes in from the Workspace. For more information on derived parameters, click here.

When you select Calibration under the Tools menu, you will be presented with the Define New
Calibration Standard dialog window. It asks you to define which parameter you want to calibrate.
For detailed instructions on creating a new Calibration Standard, click on this link.

Download a Calibration Workspace with Demo Data to try out this platform.

Calibrated Parameters (Quantitation of absolute molecules per cell)

• 
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Kinetics Overview
After reading this, you might want to look at the kinetics question/answer page for a quick
introduction to kinetics analysis techniques.

Kinetics analyses are performed by selecting a population in the workspace and choosing Kinetics...
from the Platform menu. If a gated population is selected, then the kinetics analyses are performed
only on the cells that fall within the gated subset.

Kinetics requires that there be a parameter collected with time information; and that this parameter is
named "Time". If FlowJo doesn't find a time parameter, then it asks if you would like to create a
derived parameter that corresponds to time. In this case, FlowJo will assume that there was a constant
event rate during collection. The time parameter is created via the Derive Parameters dialog, which
you can also select directly from the Platform menu. Once you have defined the Time parameter, you
can continue.

FlowJo begins kinetics analysis by showing the graph window for kinetics analyses, as shown below.
This window shows the information and controls associated with kinetics analyses.

Click this vertical button to choose a parameter to analyze vs. time.1. 
This button lets you create multiple time slices (see below) in one step.2. 
Choose a function to be applied to the Y parameter for display. Adjust other parameters of the
display. More details here.

3. 

When you create time slices they are displayed here beneath All Events.4. 
The Copy button copies the tabular data to the clipboard.5. 
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Start time and end time of each time slice.6. 
The time of peak value within each slice.7. 
The peak value itself.8. 
Average value over time slice.9. 
Linear least-squares within the timeslice.10. 
Area under the curve.11. 
The final column contains the elapsed time for each time slice, Delta T.12. 

Since Time is always on the X-axis, you cannot change the X-axis. However, you may select any
parameter to be displayed on the Y axis. FlowJo, by default, will display a ratio parameter (if one
exists); otherwise, it will choose one of the collected parameters.

The value that is displayed in the line graph is a function of the Y parameter (the name of this
function is shown directly above the graph). In this case, the line graph is the 75th percentile of
fluorescence for the "Ca" parameter as a function of time. No smoothing has been applied ( a
Gaussian smoothing algorithm with a width of 3 seconds or a Moving Average smoothing is
available.) And Auto-scaling is on. To change the function of the Y parameter that is displayed, use
the Kinetics Options window. Activate this window by opening the triangle beside the word Options
(Number 3 in the graphic above.) Refer to the Options page to see what other kinds of functions you
can display.

Just below the graph is a table of statistics regarding the computed parameter. Each line in the table is
a timeslice; by default, the first timeslice is All Events, with a begin and end time that covers the
entire collection. The statistics computed for events within a time slice include the peak time and
value and the slope of the line within a timeslice. The units for the peak value and the slope are the
same as the units shown on the Y axis - linear scaled units for the parameter being displayed. You can
copy this information directly to a spreadsheet or word processor: click on the Copy button just below
the left edge of the table, and a copy of the table is placed on the Macintosh clipboard. If you switch
to a spreadsheet application, select EDIT/PASTE and the table will be copied in to your spreadsheet.

To create a new timeslice, simply click and drag within the graph as you would to create a histogram
gate. You will then be asked to name the timeslice; you may also fine-tune the start and end times in
the naming dialog window. Shown below is the result of analyzing the graph above: first, the events
were smoothed (via the kinetics options); then, three timeslices were defined to cover the background,
response, and resolution time periods. Note that the statistics below the graph reflect these new
timeslices, and pertain only to the events within the timeslices. If you wish to delete a timeslice, select
it by clicking on the darker horizontal line across the time slice, and press the delete key. (Use
option-delete to avoid the confirmation query).
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Note that the statistics always reflect the smoothed data: thus, by changing the smoothing parameters,
you will affect peak time and value. (The slope is generally insensitive to smoothing).

When you select the Copy button from the kinetics window, two different items are placed on the
clipboard. One is the graph itself (hold down the option key to include the timeslices as shown in the
window). This is what you will see when you subsequently paste into a drawing program. In addition,
FlowJo puts the actual kinetics data itself on the clipboard. Note that these values are the smoothed
values, if smoothing is selected from the kinetics options .

Kinetics nodes (shown in the workspace with a "t" icon ) behave like other nodes: you can drag &
drop them to copy and apply them to other populations. When you copy kinetics analyses to other
nodes (in the workspace), all of the timeslices are copied as well as the specific information regarding
smoothing, parameter selection, etc. You can update existing kinetics analyses for other nodes to be
similar to one you have just modified by dragging the newly modified kinetics node onto the original
population: FlowJo will ask you whether you want to replace the contents of the existing nodes; select
Yes. You can apply kinetics nodes to group nodes to perform batch kinetics analysis.

See the Tips page for kinetics analyses.

Download a Kinetics Workspace with Demo Data to try out this platform.

Download the Kinetics Tech Note to print a short (four page) step-by-step guide.
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Cell Cycle
FlowJo provides a simple interface to performing fairly sophisticated DNA/Cell Cycle analysis. To
launch the Cell Cycle platform, select any sample or gated population (i.e., where you have gated out
debris or gated for a desired phenotype), and choose Cell Cycle... from the Workspace menu. FlowJo
brings up a graph window that is specially designed for cell cycle analyses. You might want to visit
the page giving hints for Cell Cycle analysis with FlowJo.

FlowJo tries to determine which parameter contains the DNA quantitation information; if it chooses
the wrong one, select the correct one from the X-axis popup menu. Then click on the button
"Add/Change Models" to begin your Cell Cycle analysis.

When you click on the Models disclosure triangle , FlowJo shows you the options below. From this
area, you can choose between the Watson (Pragmatic) and the Dean-Jett-Fox models to compute for
the data, and, if necessary, to constrain the fitting parameters by any number of criteria. The Watson
model makes no assumptions about the shape of the S-Phase distribution; it (by definition) fits the
S-phase exactly. The DJF model assumes that the S-phase is can be modeled by a second degree
polynomial (that is convoluted with gaussian distributions of varying width throughout S-phase). You
can also choose to have a synchronized peak within the S-phase as an option to this model.

Once FlowJo has computed the model, it displays the fit along with statistical data in the Cell Cycle
window, such as that shown below.
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The statistics displayed in a column on the graph will depend on which model and options are
computed, but both will include basic statistics such as the fraction of cells in G1, S, and G2, the
positions of the G1 and G2 peaks (and their widths), and the number of cells below G1 and above G2.
In addition, the RMS (root mean square) error of the fit is displayed at the top of the list. If you
change the fitting criteria, you may wish to minimize this value as a way to optimize the fit. If FlowJo
fails to fit the model(s) to the data, then it will display "Invalid" in the RMS field. In this case, you
will want to help FlowJo fit the data by constraining different parameters. See the Hints page for
ideas on how to proceed.

Choosing Split S Phase Stats will add percent values for S1, S2, S3 and S4 to the values listed in the
column on the graph. Experiment by checking the boxes that Draw Model Sum, Draw Components
and Use Pattern Fill to see if they display useful detail in your analysis. The color boxes let you
choose what colors will be displayed for the given parameter.
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In the Constraints area , the fit was constrained such that the G2 peak must be found within the
defined range. Checking Edit G1/G2 Curves produces vertical lines marked G1 and G2 on the graph.
You can drag these lines to visually adjust these gates to the graph. Dragging vertically will include a
wider range of values from the x axis, dragging horizontally will move the peak of the gate along the
histogram line.

At the top of this window is the statistics button. By clicking it, you can choose to add any of the
listed statistics to the display. I have chosen Median FL2-Area and it is displayed as the red line on
the graph.

Selecting the Create Gates button adds gates discribing the non-overlapping areas of the cell cycle
populations to the selected parent population in the Workspace. Cell cycle analyses can be copied
between subsets and between samples, and even to groups, just like every other analysis in FlowJo. In
this fashion, you can compute Cell Cycle analyses on every sample in an experiment. In general, you
will begin by analyzing a control sample, and use this control sample to define ranges for G1 and G2.
If you have unusual distributions, constraining the fit by these ranges will help FlowJo determine the
proper distribution of cells. Once you have defined the ranges and the fit, drag the analysis to other
samples (or the group).

Selecting the Show Overlay button produces a histogram overlay in the Layout Editor showing the
three subpopulations overlaid on the same graph space.

You can drag Cell Cycle analyses from the Workspace to the Layout Editor to generate reports that
contain the graphs, the models, and the basic statistics (fraction of cells in G1, S, and G2). You can
also copy the table of statistics to the clipboard by clicking on the button right above the table--and
then paste into any spreadsheet or word processor for further analysis.

You may also wish to view the page on hints for performing Cell Cycle analyses.

Download a Cell Cycle Workspace with Demo Data to try out this platform.

Cell Cycle
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Proliferation
Using flow cytometry to track cell generations is now possible, thanks to the introduction of cell
tracking dyes. FlowJo presents a graphical display and a table of data on each generation in the
subset. This will provide you with information about how many cell divisions have occurred. In
addition the FlowJo Proliferation Platform draws gates in order to separate each generation.

Start by clicking on the population to analyze and selecting Proliferation from the Tools menu.

This brings up the Proliferation Platform.
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Select a parameter on the X-axis.

The default number of peaks is 8, although it is important that the chosen number of peaks exceed
the actual number of peaks in the data.

It is useful to initially calculate the model without constraints (adding constraints as necessary to
obtain the best fit).

Calculate the model by clicking on the Calculate button.

Click a right arrow to cycle through samples.

Click the down arrow to selects a sample.

Click the clipboard to copy table to clipboard.

The Division Index*, Proliferation Index*, and the %Divided* are explained below.

The better the model fit, the lower the Root Mean Square (RMS).

Gates dividing the generations can be created by clicking the Create Gates button. (Draws a gate
halfway between each peak).

*Division Index is the average number of divisions that a cell (that was present in the starting
population) has undergone. For example, if half of the cells in the starting population divided and the
average number of divisions was 4, the Division Index would be 2.

*Proliferation Index is the average number of divisions that those cells which divided underwent.
For example, if the average number of divisions for all the cells was 4, the Division Index would be 4.
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*%Divided is the percentage of the cells of the original sample which divided (assuming that no cells
died during the culture). For example, if half of the cells in the starting population have divided, the
%Divided = 50%.

These statistics are related in the following way: Division Index = (Prolif. Index)(%Divided)

The Model Parameter Adjustments can be used to obtain a better fitting model.

As with all other platforms in FlowJo, the Proliferation Node can be applied to groups of samples by
dragging.

Each generation can be analyzed separately (double click the generation number to open a graph).

Proliferation Studies
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32 Bit Data Settings

Digital Transformation settings for DiVa files
to view non-DiVa transformation settings, click here

to view hints on DiVa data export, click here

The top four checkboxes allow you to control which parameters may be displayed as Log. Check the
box to view this parameter as Logarighmic scaling, leave unchecked for Linear.

Linear Channel Number - select which of your linear channels should be the "0".

Number of Decades splits into Area parameters (ex. FL1-A) and Height parameters (ex. FL2-H) and
you can decide how the data should be scaled: 4 or 5 decades? This setting does not affect your data
distribution, only the scaling of the axes in the Graph Window.

If you check the Auto-Transform box, all DiVa files exported as FCS3.0 will be transformed
according to the settings in this panel.

Number of Decades - How many decades would you like to plot? This setting does not affect your
data distribution, it is equivalent to "zooming".

Add'l Negative Decades: How many additional decades? We recommend starting with 0.5 and if
events are still present on X or Y axes, then keep increasing this by 0.5. You can change transform
settings by right-clicking on the T button on your Graph Window's axes.
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Width Basis - How wide the linear region should be.

BiExponential Transformation Overview

• 

Table of Contents

 32 Bit Data Settings 49



Output
FlowJo has a great number of output capabilities, encompassing graphics, statistics, or raw data.  It supports
printing from all the different views of data, as well as copying data through the clipboard or file system.
FlowJo contains a special editor for the creation of Tables (statistical outputs) and Layouts (graphical
outputs). 

This section is divided into six parts, each discussing different aspects of generating output out of FlowJo. 

A table is a text file containing one or more rows of data, that correspond to frequencies and other statistics
derived from a single sample.  The table editor lets you construct the set of statistics, and then generates them
for every sample in the current group.

A layout is a graphical image, composed of individual elements that represent boxes, lines, text and graphs.
Elements are created by dragging populations and statistics from the workspace into the canvas of the layout
editor.

Both tables and layouts can perform batch output generation using the current Group as the set of data files
from which to draw information.  You should be familiar with the use of groups to use Tables and Layouts
efficiently.

Printing is supported in all sections of FlowJo.  The print command has different behaviors depending on the
type of window.  Specific behaviors include printing the workspace structure or single graph, as well as a set
of graphs, layouts, and full report generation.

A novel feature of FlowJo is its ability to generate movies from flow data.  Any graph window can add a third
dimension to the view by slicing views of the events by a third parameter.  You can also view any graph as a
function of time or the event number during the sample collection.

You can also export raw data for analysis by other programs.  You can export any gated population (or the
whole sample), as its own FCS file or as tab-delimited text.  You can quickly generate small subset files,
optionally reducing the event count or even the parameter list.  You can use this function to reformat FCS data
into spreadsheet-friendly text.

Histograms (and Cell Cycle graphs and Kinetics graphs) can be exported as well.  Here you will get two
columns of "XY" data, where the first column is the channel number (or time for Kinetics), and the Y value is
the event count or processed statistic.  By default, whenever you select Copy (or press control-C) when
viewing a histogram, cell cycle, or kinetics graph, FlowJo puts two distinct items into the clipboard:  one is a
graphic picture of the data (that you can paste into graphics applications); the other is a text representation of
the data (that you can paste into a spreadsheet).  Sometimes graphics applications will erroneously pick the
text item for pasting; if this happens to you, you can ask FlowJo not to export the text data from these graphs
(via the Preferences dialog).

Finally, some notes on publication quality graphics out of FlowJo. Several nitty gritty details of data
formats are explained in order to support post-processing of FlowJo's output.  Also included is the gallery of
FlowJo images, as examples of what kinds of output you can create.

Output:
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The Layout Editor
The Layout Editor is a powerful tool in the creation of both analysis and publication graphics. It is
designed to create data display layouts which can contain one or more graphical objects, such as
graphs, text and lines. It works like a page layout program, but the graphs are live and will be updated
to reflect any change in the data or gating. The page describing the Layout Editor controls explains
the tool palette, commands and options associated with the editor. The page describing layout
elements also contains useful information about FlowJo's myriad presentation capabilities.

Using the Layout Editor, you can generate graphical reports that can do any of the following:

Show multiple different graphs from the same gated subset♦ 
Create a report mixing graphs from different subsets or samples♦ 
Overlay dot plots, histograms, or Kinetics analyses♦ 
Mix statistics, text items, tables, boxes, lines, and other items with your graphs♦ 
Generate a report for every sample in the workspace based on the layout of one sample and its
analysis.

♦ 

Layouts are live, in that the graphic window is updated whenever any of the gates or statistics change
(because you moved a gate, or change an analysis, etc.). You never have to worry about whether to
update the reports or not; FlowJo will do so automatically!

The Layout Editor knows how to iterate or batch , that is, to create the same layout for many different
samples based on the layout of one sample. It can iterate over every sample in a group, or via Panels
where graphs from different samples are combined in a single layout.

Iterated layouts can be previewed as they will print or animated as frames in a Quicktime movie. The
Layout editor can save, print or export the layout as a graphic file, as well as save it in HTML for
export to the web.

Because a layout contains many different graphs and therefore can take a long time to generate,
FlowJo supports placeholders to make the editor more responsive while creating the layouts.

An example can be studied in the FlowJo advanced tutorial.

See Also: Workspace, Table Editor, Groups

Layout Editor
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Copying Graphs
You can copy and paste any graph into another Macintosh program. Simply select Copy from the
Edit menu (or use command-C) when the graph window is foremost on your screen. Switch to the
other application, and select Paste.

The graphic object is a grouped selection of multiple objects. Selecting Ungroup successively in the
other program will ungroup these objects, which include: the axis titles, the axis notations, and the
graph itself. All text is in Palatino font, size 12 by default; however, you can easily change the default
font in the Preferences dialog on the Text tab . The format of the exported graphic depends on the
type of graph as well as a preference setting.

Histograms and CDF plots are always exported as vector art. You can ungroup these and change the
line style or fill pattern for the histograms.

Note also that when you copy a histogram graph, two items are placed on the clipboard: the graphic
rendition as well as a text rendition of the histogram data itself. Depending on the program into which
you subsequently do a paste, the correct item will be inserted. For more information, see the Webpage
about exporting raw data.

This is also true when you copy a graph from the kinetics window: both the graphic rendition and the
spreadsheet values are copied into the clipboard. If you paste into a spreadsheet, you will get two
columns: one is time, the other is the computed value as a function of time. For more information, see
the section on the kinetics platform.

The other types of graphs are, by default, exported as a black & white bitmap (except for density and
pseudo-color plots, which are 256-color bitmaps). Bitmaps are most quickly drawn by other programs
and the representation is quite good. However, bitmaps cannot be resized without risking significant
distortion. If you want to export high-quality vector art for all graph types, select PICT or Quicktime
format in the Preferences dialog on the Output tab . Now copied graphs (or layouts) will have
high-quality line graphs that can be resized without loss of information. However, it may take the
drawing programs considerably longer to present them to you; especially for plots that are not contour
plots. See the information on making publication quality graphics.

If you hold down the option key when you select Copy from the menu, then FlowJo will include with
the graphic any gates that are drawn on the current graph. (You can change the default behavior of
including gates or not through the preferences dialog).

Copying graphs to other programs (generating publication-quality graphics)
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Copying Gates
Copying analyses (gates, statistics, kinetics, cell cycle, etc.) from one sample to another is very easy:
simply click on the analysis (a gate, statistic, or population node), and drag it to the destination. The
node is added on to the destination node as a "child" of the destination (i.e., it is applied to only those
cells which fall within the population you drop the analysis on).

You can drag entire trees around this way, selecting children, parents, or multiple nodes.

Note that if you drag a subpopulation onto a population which already has a subpopulation with the
same name as that you are copying, then FlowJo asks what you would like to do: you can replace the
existing subpopulation, you can retain the existing subpopulation, or you can add the current
subpopulation with a change in its name. (The reason for all of this is that FlowJo does not allow you
to have two subpopulations with the same name at the same level of analysis). These options are more
fully described in the pages on replacing nodes.

You can automate the process of applying analyses to samples by using groups. You can add analyses
to a group; then every sample which belongs to the group or is later added to the group gets those
analyses. This is one of the powerful batch analysis features of FlowJo. You may view an example of
group-based analysis.

You can drag analyses across workspaces; in other words, you can drag an analysis node from one
workspace and drop it onto a sample or a group in a different workspace. You need to have both
workspace windows open to do this; simply drag from one to the other.

Copying Gates
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Tables
A requirement of many experiments is the ability to generate tabular output for further analysis in a
spreadsheet or statistics program. The Table Editor is the means by which you can generate a series
of statistical calculations for all samples in a group. These statistics can be any of the statistics FlowJo
calculates: medians, frequencies, etc. You can also use this tool to generate functions that will display
their output for every sample in a group as a column in the table. The Table Editor will use the
column specification to iterate through all the populations in the current Workspace group. The rows
of the finished table will be the populations, the columns will display their values.

From the Workspace window, open the Table Editor. This can be done in one of two ways: either
click on the table editor function button  in the workspace window, or select the Table Editor

from the Windows menu. (Ctrl-T)

Use the Table Editor to create a new table definition. A table definition is not the output data itself. 
Instead it is the specification of what columns the table will contain, when it is generated. 

You can create new empty definitions, duplicate existing ones, or delete them using the
buttons  in the top left corner of the window. Each different table definition listed in the left
hand column of the Table Editor is a template for a table.

Dragging a population node into the Table Editor will add its frequency statistic to the table. Each
statistic in the right panel of the table editor will correspond to a column in the output table; you can
change the order of these columns by clicking and dragging the statistics around. You can rename a
column at any time by clicking in the Custom Name column and typing the new name. The table is
created for those samples in the currently-selected group: check to make sure that the appropriate
group is selected in the Workspace window before you create the table!
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You can add statistics and keywords to a table definition, simply by clicking on them in the
Workspace window and dragging them to the definition pane on the right hand side of the Table
Editor window. You can select multiple nodes in the Workspace and drag them all at once. More
generally, you can click on the Column Definition button to add Statistics, Keywords and
Formulas to your table whether or not you have previously defined them in the Workspace.

The Table Editor will automatically calculate these column values for each sample in the currently
selected group. When you create a table, each column value in the Table Editor is applied to every
applicable sample in the current group--irrespective of any population you actually dragged into the
table.

When you create a table, FlowJo will cycle through all of the samples in the currently selected group.
For each statistic, keyword or formula in the table definition, it searches for an appropriate population
in each sample. If one is not found, then it leaves a blank for that entry. (For instance, if the statistic
you created was the median FITC fluorescence of a Lymphocyte gate, and the Lymphocyte gate does
not exist in all samples, then those samples will have blank values for this statistic). Therefore, the
statistics are only gathered for those samples which have the appropriate stains, gates and keywords
already applied to them.

Whether you define columns by dragging from the Workspace or selecting the Column Definition
button, you can customize the result in the Column Information dialog. To edit the details of an
existing column definition, click on the Column Info button. Here you can name the column,

define it as a control value, hide it from the finished table and format the output according to criteria
of your choice. If the values generated exceed an amount you choose, or have standard deviations
greater or less than a chosen value, they can be formatted differently in the output table for easy
recognition.

Follow these links to see how to enter and customize Statistics, Keywords and Formulas in FlowJo.

When your column definitions are complete, select the Table Generation button to view the
output table. You will see the following dialog...
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In the Sample data from: pull-down menu, you can choose the group that the table is about. All the
groups you have defined in the Workspace will be listed here.

In the Iteration source: pull-down menu choose whether to batch through the data by sample or by
keyword. The keyword list is compiled from the properties of the files in the Workspace.

Next you can choose what items will show in your finished table. Check those items you want to
show. If Show Borders is checked, you can drag the slider below it to determine the thickness of the
lines in your table. The black square is a button. Click on it to choose the color of the lines.

Finally, the Destination: drop-down list tells FlowJo what you want to do with the table.

Display in FlowJo will open the table in its own window.♦ 
Save File offers you the choice of formats shown on the right as well as a choice of
directories and filename.

♦ 

Upload to FTP lets you specify the information you need to send your table to the remote
storage site of your choice:

♦ 
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Print brings up the familiar Windows print requester.♦ 
When you have chosen the destination of your table, select the Generate Table button to view your
table.

Tables
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Printing
To print a single window, select the Print command from the File menu when that window is
frontmost.  You will see the Print dialog offering choice of printer, number of copies and so on.
In addition, you can preview the page to be printed, save it as a PDF file or fax it from the Print
dialog.

For example. you can print the contents of the workspace window. Select Print from the File
menu. The printout will have the entire portion of the sample and analysis half of the window
(the lower portion). All currently visible samples, analyses, and statistics nodes will appear in the
printout.

For more complex printing, you should familiarize yourself with the workings of the Layout
Editor. This tool provides options for easily creating reports with graphs, overlaid histograms,
statistics and any amount of annotation and elaboration you desire. The reports are created by
taking the first sample you set us as an example (tile) and batch processing through all the
samples you wish to summarize. The resulting report can be rendered in several formats: new
layout, print preview (tiled report), movie, or web report. In addition, you can print this report
directly.

Printing
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FlowJo Menus
This is a picture of the main menu in FlowJo for Windows. Click on a menu item below to read about each
of the choices in the menu.

File Menu

New Workspace
Opens a new, empty workspace.

Open Workspace
Open an existing workspace. Use the Open Workspace dialog to select a workspace that you have previously
saved.

Open Recent Workspace...
Displays a list of the 10 most recently saved .wsp files. Click on one to reopen it.

Open Workspace in New Window
Opens a saved Workspace without closing the current one.
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Save
Saves the current contents of FlowJo including tables, layouts and analyses as a .wsp file. If it has not been
saved before, FlowJo will ask you to name the .wsp file.

Save as...
Saves a Workspace with a new name.

Save as Template...
Saves the Workspace and analyses but without data files. You can open a template and add new data. If
identically stained, it will be arranged in the same groups and gated with the same gates as the data from
which the template was made.

Revert
Reopens the current Workspace from disk. Any changes made since the last save operation will be lost.

Page Setup...
As in most Windows programs, this item opens the Page Setup Dialog to prepare the page for print

Print Preview...
Displays a preview of the page you are about to print.

Print...
Opens the Windows Print utility.

Close Workspace
Exits FlowJo. If you have made changes to the Workspace, FlowJo will ask if you wish to save those changes.

Exit
Exits FlowJo. If you have made changes to the Workspace, FlowJo will ask if you wish to save those changes.

[Top]

Edit Menu
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Undo
Cancels the last operation

Redo
Reinstates a cancelled operation

Cut
Removes selected text or items and places them on the clipboard.

Copy
Copies selected items to the clipboard

Paste
Inserts the contents of the clipboard into the active selection.

Clear
Removes selected text or items and places them on the clipboard.

Select All
Select all items in the current window.

Select None
Deselects any existing selection in the Workspace.
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Select Every
When you mouse over Select Every the menu on the right appears. You can select every other, third, fourth,
fifth sample etc. based on the value chosen from the popup menu. This can be useful with regular protocols
where, for example, every fourth tube is stained with the same reagent. Being able to select by interval is
convenient for dragging several regularly spaced samples to a group.

Select Equivalent Nodes
Selects all data entries that occupy the same place in the gating hierarchy. This way you can quickly select, for
example, all of the CD4 gates for all samples.

Open Graph Window
Opens the graph of the selected population or populations. Same as double-clicking a population name in the
Workspace.

Collapse All
Collapses the subset display in the Workspace so that only the imported tubes and their disclosure triangles
are visible.

Expand All
Displays the complete hierarchical analysis structure with gated populations, statistics, and other analyses
displayed.

Collapse Level
Select a population or subset. Collapse Level will close the analysis hierarchy below the selected level on that
item. To reopen it select Expand Level, or click the disclosure triangle next to the item of interest.

Expand Level
Reveals any hidden items in the analysis hierarchy. Equivalent to clicking the disclosure triangle next to a
hidden analysis hierarchy.

Text Traits...
Opens a dialog within which you may set the style, color, font

[Top] 

Workspace menu
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Show Workspace

Brings the workspace window to the front.

Show/Hide Statistics

Hides (or shows) all statistics nodes in the workspace.

Edit Workspace Columns...

Brings up a dialog to change the information displayed in the sample list of the workspace window.

Sort Sample List...

Brings up a dialog that lets you sort the sample list by a variety of keys.

Add Keyword...

Adds an additional keyword to the sample's record in the workspace, for additional annotation. Note that this
does not alter the FCS file, but only creates the keyword within the scope of the current workspace. To
permanently and universally add the keyword, you should use ProJo.

Copy Value to Group/Create Value Series

This takes the value in the currently selected field, and applies it to all of the samples in the current group.
This is useful for creating keywords with a value shared by all of the members of a group. When you select a
keyword and hold down the Option key, you see Create Value Series. A dialog lets you set the initial
keyword value, and increment it over subsequent data entries.
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Make Groups From Keys... /Groups From All Values

Opens a dialog to choose a keyword as the basis for a new Workspace group. You can give the new group its
own color and text style here too. Option key lets you make a group or groups that share a single value of a
keyword.

Add Samples / Add Samples Into Group

Add FCS files to the current workspace. Option key lets you select a group and import new samples to it.

Add Samples From Network

Enter a URL and import samples from elsewhere.

New Group... /Put into new Group

Create a new grouping of samples. Brings up the Group Definition dialog. If you first select some samples
you want to group then hold down the Option key, Put into new Group creates a group of those samples. The
same results from the keyboard command Option-command-G.

Recalculate / Clear & Recalculate

This command asks FlowJo to compute all statistics and frequencies for the populations that are selected. In
addition, all descendants of selected populations will also be recalculated. Clear & Recalculate Forces
FlowJo to recompute all statistics for all populations, whether or not they have previously been computed.
Keyboard equivalent is Option-command-=

Unify Analyses

If you have modified a gate and decide later that it should be identical to the group's version, you can select
the gate and choose the Unify Analyses option. Likewise, if you select a group then choose a gated population
within it, you can use Unify Analyses to apply this GROUP version of the gate to any samples whose gates
have been changed. Learn more about groups.

Rename

Use this command to rename whatever item you have selected in the workspace.

Get Sample Info

Opens a dialog with all the keyword information, compensation matrix, parameters and stains from the .fcs
file for a selected sample.

Export...

Export the data from one or more samples and gates as .fcs files or chose to export channel or scale values as
an ascii (text) file. Learn more about exporting raw data.

Concatenate Samples
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Combines the data from multiple samples into a single sample and saves it to disk as a .fcs file with the name
of your choice.

[Top] 

Groups menu

[Top] 

Tools menu

Compensate sample...

Define or apply a compensation matrix. This menu item has a submenu of Compensation processes. If a group
is currently selected, then all samples in that group are compensated; if a sample is selected, only that sample
is compensated.

MultiGraph Overlay...

Click once in the Workspace window to select the sample you wish to view as a MultiGraph Overlay.
Choose MultiGraph Overlay from the Platform menu. Drag and drop a gated subpopulation node from the
Workspace menu or draw a new gate within the MultiGraph itself. Each addition to the MultiGraph appears in
a contrasting color. More details here.

Kinetics Platform
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Launch the Kinetics Platform to perform time-dependent analyses.

Cell Cycle Platform

Launch the Cell Cycle Platform to perform DNA analyses.

Proliferation Platform

Launch the Proliferation platform used in conjunction with cellular markers to study the rate of cell
replication.

Derive Parameters...

Derive new computed parameters or copy the derived parameters from a sample to other samples. You can
only add derived parameters to a single sample; you can only copy derived parameters from a single sample
that has them defined. From this menu item you can also delete unwanted derived parameters.

Define Calibration...

Launches the Calibration platform that you can use to convert between the fluorescence intensity collected on
your instrument and absolute numbers of fluorophores.

Create Background Gate...

Boolean Gates...

Select a parent population, specify subpopulations upon which to apply And - Or - And not - Or not... the
gated populations appear in the Workspace list.

[Top] 

Graph menu
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Graph Type

A hierarchical menu, from which you can select one of the following six graph types to apply to the current
graph. By holding down the option key you can change all open graphs to the new graph type.

The following are the types you can select:

...Contour Plot

Makes the current graph a probability contour plot. (Holding down Option while selecting this item causes all
graphs that are currently open into contour plots).

...Density Plot

Makes the current graph a density plot. (Holding down Option while selecting this item causes all graphs that
are currently open into density plot graphs).

...Zebra Plot

Makes the current graph a Zebra plot. (Holding down Option while selecting this item causes all graphs that
are currently open into zebra plot graphs).

...Pseudo-color Plot

Makes the current graph a pseudo-color plot. (Holding down Option while selecting this item causes all
graphs that are currently open into pseudo-color plot graphs).
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...Dot Plot

Makes the current graph a dot plot. (Holding down Option while selecting this item causes all graphs that are
currently open into dot plot graphs).

...Histogram

Makes the current graph a histogram of whatever parameter is on the X axis.

...CDF

Makes the current graph a CDF (cumulative display function) of whatever parameter is on the X axis. A CDF
is the integral of a histogram.

Graph options

A hierarchical menu, from which you can select one of the following five options to apply to the current
graph. By holding down the option key, the type will be changed for all graph windows that are currently
open.

The following options can be selected:

...Contour Levels...

For a contour plot, select the frequency of levels that are displayed. A submenu offers several probability
settings.

...Smooth

When selected, the appearance of the graph is smoothed. Effects only contour, density, and histogram plots,
does not effect underlying data.

...Show Outliers

Draws dots for all events outside of the outermost contour in contour or density plots.

...High Resolution

When on, graph is calculated at higher resolution. Requires more compute time; affects only contour, density,
pseudo-color, and histogram plots.

...Invert

Reverse the color of the current plot.

Transpose axes

Switch the X and Y axes of the current plot.

Open new window
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Opens a copy of the currently selected graph or if none is selected, a copy of the most recently selected graph.

Show defining gate

When the graph of a subpopulation is selected, this opens a graph window showing the parent population,
with the gate that created the subpopulation.

Backgate Analysis...

Displays a series of graphs showing the gating history of a subpopulation that has been gated more than once.
The final subpopulation is highlighted in each graph.

PolyVariate Plot...

Opens the controls to create a graph with multiple parameters. By adjusting these controls, subpopulations can
be separated visually.

Manually enter gate...

Brings up a dialog allowing you to specify a new gate in terms of channels, absolute fluorescence, or
percentile within a distribution.

Show Histograms...

Display a histogram of every channel in the current sample for the events shown in the current plot. This is a
MultiGraph Overlay, so you can gate on these graphs or drag subpopulations from the workspace to add to
these graphs. Each graph will display each subpopulation in a contrasting color.

Open other samples...

Opens the equivalent graph of the same population for every other sample in the current group. If the
windows are already open, then it changes the graph in that window to appear identical to the one you are
looking at. If you hold down the option key while selecting this item, FlowJo will not ask you to confirm the
operation.

Change other graphs...

Changes every other open graph to look like the one you are examining (i.e., FlowJo attempts to set the axes
to the same channels, and the graph type and options identical to the current plot). If you hold down the option
key while selecting this item, FlowJo will not ask you to confirm the operation.

Next Sample

Finds the next sample in the workspace sample list which has exactly the same gate as the current graph, and
displays it in the current window. By holding down the option key, all open graphs will cycle in this way
simultaneously. Same as Right Arrow button in the Graph window.

Previous Sample

Finds the previous sample in the workspace sample list which has exactly the same gate as the current graph,
and displays it in the current window. By holding down the option key, all open graphs will cycle in this way
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simultaneously. Same as Left Arrow button in the Graph window.

Parent Population

When the graph of a subpopulation is selected, this opens a graph window showing the parent population,
with the gate that created the subpopulation.

Child Population

Within a graph window with one or more gates, this command opens a graph of the currently selected gate. If
more than one gate is selected, the most recently selected is opened.

Shrink Gate

Decreases the area of a selected gate by small increments.

Expand Gate

Increases the area of a selected gate by small increments.

Make Movie...

Turn the current graph into a QuickTime movie, using either time or another parameter to control the display
of the current population. See the Movie platform for more information.

Copy Table...

Copies tabulated information from within Cell Cycle and Kinetics platform windows. The table is copied onto
the clipboard, from which it can be pasted into any spreadsheet or word processor application.

[Top] 

Layouts menu
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Layout Editor...

Opens the Layout editor.

Make Batch Layout

Takes the current graphic analysis in the Layout editor and reproduces it in the layout based upon each sample
in the current group.

Iteration Options.

Brings up the dialog box allowing you to change the iteration variable, to support complex multi-sample
reports. More information is available in the Layouts section.

Save Layout Settings/Save Settings as Default

Stores a copy of your layout's tiling settings so that future layouts made with this template will default to the
same settings. This command is only enabled for the Print Preview Window.With the Option key down, Save
Settings as Default takes the current layout settings and makes them the default used when new layouts are
created.

Get Item Info.
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Brings up the dialog to edit the attributes of any selected object in the layout. This may be line weights and
colors of an arrow or box, or the axes or smoothing algorithm in a graph.

Open Original Graph

With a graph selected in the Layout Editor window, this item opens a Graph window with the same data
displayed.

Bring To Front

Operates on the selected object(s) in the layout. Causes it to be drawn on top of other items.

Move Up

Operates on the selected object(s) in the layout. Moves the selected items one step higher in the layer order.

Move Down

Operates on the selected object(s) in the layout. Moves the selected items one step lower in the layer order.

Send To Back

Operates on the selected object(s) in the layout. Moves the selected items to the back of the layer order,
causing others to be drawn on top these.

Insert Picture...

Provides a dialog box for you to select a file in PICT format to be displayed in the current layout. Conversion
of graphics formats GIF, TIFF, or JPEG requires either QuickTime, Clip2Gif or other plug-in translator.

Group

Multiple objects can be grouped so that they can repositioned, duplicated or deleted all at once. Select two or
more items and invoke the Group command and they can be handled as a single object.

Ungroup

Devides a group into individual items again.

Put into Grid / Ungrid

Grids are an advanced form of groups which also determine the positioning and size of objects. As a grid is
resized, the spacing and sizing of the elements behaves consistently across all of the cells in the grid. More on
grids.

Get Grid Info...

Use Get Grid Info... to adjust the attributes of a grid. If a grid is currently selected, the Get Item Info...
command will set the attributes of the contents of the selected cell.

Transpose Grid

Table of Contents

72



The Transpose Grid command changes the number of rows to the number of columns and the number of
columns to the number of rows. So a 3 column by 2 row grid becomes a 2 column by 3 row grid. Items are not
moved among cells, but if the cell moves, the content moves with it. More at Grids.

Zoom In

Increases the magnification level, so that objects are drawn larger. More controls of the layout's magnification
are found in the bottom right corner of the Layout window.

Zoom Out

Decreases the magnification level, so that objects are drawn smaller. Magnification levels range from twice
normal size to one eighth of normal size. More controls of the layout's magnification are found in the bottom
right corner of the layout window.

Align.

Invokes the custom alignment dialog, which will facilitate building publication quality layouts. The
Alignment commands are not enabled unless two or more items are currently selected in the layout. Many
alignment and distribution options are available, including the relationship of objects to a grid, and the
alignment of the axes of multiple graphs.

Align Horizontal

This item shows the submenu which contains the commands for four different ways of aligning the horizontal
component of a set of layout options: by left edge, by right edge, by the center, or such that centers are
equidistantly distributed between the leftmost and rightmost objects' current positions.

Align Vertical

Holds the submenu which contains four alignment commands governing the vertical component of a set of
layout options: by top edge, by bottom edge, by the vertical center, or such that centers are spaced evenly top
to bottom.
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Tables Menu

Table Editor...

Define or create a new table of statistics. Brings up the Table Editor dialog window.

Make Table

When you have chosen the contents of a new table in the table editor, this command constructs the table and
opens it in a new window

Iteration Options

Opens the Iteration Options Dialog box to specify the group and the common parameter with which a batch
will be created.

Add Keyword

This menu item opens a dialog for adding a Keyword to a table. Choose a sample from which to select a
keyword. A list of that sample's keywords appears.

Add/Edit Formula Column...

This opens the Create Formula for Table dialog. Defines the terms of a new formula to be applied as a
column of values for each population in a table. If a formula is already selected in the Table Editor, this dialog
allows you to edit it.

Special Formatting...

Opens the Define Column Attributes dialog. Name or rename a column, select an iteration value, choose
special text formatting for values in a chosen range.

[Top] 

Windows Menu
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Table Editor...

Define or create a new table of statistics. Brings up the Table Editor dialog window.

Layout Editor...

Define or create a new layout for graphics presentation. Brings up the Layout Editor dialog window

Other Items In the Windows Menu

The names of each of your documents and work windows are added to this menu, each time a new window is
created. This can be used as a navigation tool, to be able to bring you back to a desired window, after it has
been covered or obscured by other windows.

Help Menu

FlowJo Reference Manual

Launches a web browser with the main help pages.

New Features in This Version

Launches a web browser with the list of new features.

FlowJo Tutorials

Launches a web browser with links to download our tutorials.

Check for New Version

Launches a web browser with a link to the latest version download.
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Contact FlowJo Support

Launches a web browser with links to the Bug Report Form and our contact details.

Menus

Table of Contents

76



Preferences
There are a number of default behaviors of FlowJo which you can alter. These are modified through the
Preferences dialogs, shown below. To get to these dialogs, select Preferences under the Edit menu in the
Workspace, Graph window or Layout Editor. The Workspace tab is explained just below. The
Administrative tab is explained below that.

Templates and workspaces are now delivered with the preferences preset.  A workspace may contain a
preference element, or any subset of the elements and attributes supported in FlowJo.   The setting and saving
of preferences is primarily accomplished locally in each of FlowJo's tool windows.  If you change a setting
and want to keep the change for future use, go to Edit > Save State to Preferences. New operations of the
same type will use the settings you saved. On exit, workspace, templates and layouts carry their current font
information with them.

Workspace Tab

There are two tabs with preference settings. Above is the Workspace tab. Keywords lets you choose how
FlowJo will name .FCS files as they are loaded. The Default setting uses the .FCS Sample ID keyword. Use
data file name will use the name that appears in the computers file manager. If you choose Keyword
Combination you can select one or more keywords from the drop-down list. If you choose more than one
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they will appear together in the sample list. For example Sample ID plus $DATE will produce a name like
Sample 3 29-Jul-05.

Next you can have FlowJo warn you when the percentage of events compressed on the axis of a graph, as
displayed with the current settings, exceeds a percentage you set.

Remember Open Windows at Startup will instruct FlowJo to reopen the set of windows that were in use
when it last exited the program.

Check the Remind to save every x minutes if you want FlowJo to open a dialog reminding you to save your
work.

Save with incrementing version number automatically adds saves your workspace without overwriting
earlier work. Instead a version number is added to the name and both versions remain accessable on your hard
drive.

Child Populations

Display other parameters than in gating plot Checking this box causes FlowJo to display gated
subpopulations with the axes labeled differently than the parent population. If there are other parameters to
choose from, FlowJo will choose new parameters.

Show child graph:

Same as Parent Graph When you open a gated subpopulation, the graph type is the same as the parent's
graph type.

Default set in preferences Select this option to choose the type of graph a subpopulation should use. Open a
subpopulation graph, change it to the desired type, then select Edit > Save State to Preferences

Blank graph Child population graph will be blank.

If you wish to return preferences to their original state, select the Reset to Defaults button. 

Administrative Tab
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Email Options Our email address is entered by default. Enter your email address in the second box. Check
the Email problems to FlowJo so that, in the unlikely event that the program should become unstable, an
email message to us will be generated automatically with information that will help us prevent a repeat of the
problem.

Hardware Address Displays the hardware address of the machine upon which FlowJo is running. This
number is useful to us when we create a new license for a user. A FlowJo license is generated for a particular
computer using this number.

WiFi HW Address This box will display the hardware address of a WiFi wireless ethernet adapter if one is
connected to your machine. It is shown here to prevent confusion between the computer's address and the
adapter's address when issuing a license.

Serial Number This is the box where you will cut and paste a serial number mailed to you from us. Once
entered, FlowJo will run as licensed software.

Proxy Settings Button... If you use a proxy to access the internet, this button will open up a dialog where you
can enter your Host and Port settings. This will allow FlowJo to access the World Wide Web for help files
and other references.

The Mute sounds button lets you shut off FlowJo's sound signals.
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Select Don't Check For New Versions of FlowJo to prevent pop-up notification when a new version appears
on our Web site.

Select Check For New Beta Versions of FlowJo to be notified when a new beta version of FlowJo appears
on our Web site.

Preferences
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Techniques
This section discusses different techniques you can use to analyze data more efficiently with FlowJo.

FlowJo gives you the most flexibility possible with exported graphics.  You can easily ungroup any graphic,
and change the font attributes, line styles, etc., to make any graph look exactly the way you want!  The first
page in this section gives you some additional hints on exporting graphs.

The greatest strength of FlowJo is its ability to represent batch analysis in a simple and flexible structure. 
Don't expect to find a macro language or scripting extensions.  Our approach lies in the grouping structure,
within the workspaces. Create your layout, and with a single button, produce a stack.  The stack can be shown
as a new layout, a tiles picture or a movie.  There's even a section about how to cancel batch jobs once they've
been started

Drag-and-Drop is an important skill to learn if you are going to be a fluent user of this program. This section
talks about the semantics of what it means to drop gates or statistics onto populations.  A few modifier keys
can save you all sorts of time.

Indeed, modifier keys, especially the right mouse button are used heavily in FlowJo.

Tips and Techniques:
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Techniques
This section discusses different techniques you can use to analyze data more efficiently with FlowJo.

FlowJo gives you the most flexibility possible with exported graphics.  You can easily ungroup any graphic,
and change the font attributes, line styles, etc., to make any graph look exactly the way you want!  The first
page in this section gives you some additional hints on exporting graphs.

The greatest strength of FlowJo is its ability to represent batch analysis in a simple and flexible structure. 
Don't expect to find a macro language or scripting extensions.  Our approach lies in the grouping structure,
within the workspaces. Create your layout, and with a single button, produce a stack.  The stack can be shown
as a new layout, a tiles picture or a movie.  There's even a section about how to cancel batch jobs once they've
been started

Modifier keys, especially the right mouse button are used heavily in FlowJo.

Additional Techniques and References
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Windows Template
FlowJo for Windows requires a Pentium class or higher processor, running Windows 2000 or
Windows XP, with at least 512MB RAM and a USB port.
The amount of samples FlowJo can open depends on how much memory is installed.

Flowjo will consume 30-90 megabytes of physical RAM. We don't recommend that you try FlowJo
PC on a system with less than 128 megabytes of RAM!

To Find out how much RAM your PC has, open task manager (ctrl+alt+del):

In addition, the Java minimum system requirements are as follows:

IE 5.0 or greater
Pentium 166MHz or faster
Min 54MB free space
Min 32MB of RAM

Windows system requirements

• 
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